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TE nT (Translation Environment Tools) CAT (Computer Assisted Translation)

- 1]
Elektroniska ordbocker, termlistor och termdatabaser
Program med oversattningsminnen (CAT-verktyg)
Maskinoversattningsprogram
Internet
Konverteringsverktyg (filformat)

Ordrakningsprogram
Termextraheringsverktyg

Program for kvalitetssakring

Program for oversattning av programvara
Taligenkanningsprogram
Projekthanteringssystem



Elektroniska ordbocker och ordlistor

]
Elektroniska ordbocker:
Samma innehall som i bocker, i samarbete med forlagen
Sokverktyg kan ibland aktiveras fran texteditorn

Installeras pa
lokal dator/telefon

Eller som online-tjanst

Exempel:

Langenscheidt, Larousse, Collins, Norstedts etc.

WordFinder m.m.
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Elektroniska ordbocker och ordlistor
]

https://www-ne-se.proxy.lnu.se/ordb%C3%B6cker/#/

@ & https://www-ne-se.proxy.lnu.se/ordbbcker/#/ e @0

- UPPSLAGSVERKET ORDBOCKER PLAY LAROMEDEL
Ordbocker Engelska - Svenska H = Skriv in ditt ord n

O Lilaordboken @ Storaordboken O Professionella ordboken O Tekniska ordboken

Vilken av vara ordbécker vill du sbka i?

Svenska 2 Engelska Ei3 Tyska

Svensk ordbok Svenska - Engelska Svenska - Tyska
Svenska synonymer Engelska - Svenska Tyska - Svenska
Spanska = Franska 01 Arabiska

Svenska - Spanska Svenska - Franska Svenska - Arabiska
Spanska - Svenska Franska - Svenska Arabiska - Svenska
Italienska 01 Ryska =

Svenska - ltalienska Svenska - Ryska

ltalienska - Svenska Ryska - Svenska

Ovriga sprak - Lexinordbacker fran Sprakradet, Institutet for sprak och folkminnen

Svenska - Albanska Svenska - Kroatiska Svenska - Serbiska (kyrillisk)
Svenska - Amhariska Svenska - Nordkurdiska Svenska - Somaliska
Svenska - Azerbajdzjanska Svenska - Sydkurdiska Svenska - Tigrinska
Svenska - Bosniska Svenska - Pashto Svenska - Turkiska

Svenska - Finska Svenska - Persiska

Svenska - Grekiska Svenska - Serbiska (latinsk)

A
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Elektroniska ordbocker och ordlistor

WWW.WO rdfl n d er.com v/m GYLDENDAL &.Wolters Kluwer Samfunds

Health Litteratur

OXFORD sroomssury
ZANICHELLI UNIVERSITY PRESS
WordFinder Professional [En-5v WordFinders engelska ordbok] -

Arkiv Redigera  Visa  Verktyg  Lexikon 2 Colllns AKADEMI

me s a0z sl e B WSOV OIS
angenscnel

= ] '! Porto Ei:i‘:;i,'f?;é’,fi‘i;!?g"t TERMINOLOGICENTRUM

Edltora HDEPLI CAPPELEN DAMM

captor La Libresia Internazionale

:Ez:n ka:] 1 [f] 2 vagn); the Car Karlavagnen 3 sparvagn 4 j&mvégsvagn 5 hisskorg "‘1 ;}QNS - LAROUSSE

car

+

captivity N

carafe

car alarm
caramel
carapace
carat
caravan
caravan park
caraway
carbide
carbine
carbohydrate

carbolic

g ©2018 WordFinder Software International AR ‘WordFinders engelsia ordbok

anne@akwronsulting.se
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Internet: termdatabaser

http://www.rikstermbanken.se

Uppbyggd av
Terminologicentrum TNC,

L () www.rikstermbanken.se/mainMenu.html e & || Q sk som Iades ned dec 20 18
&4 RIKSTERMBANKEN | .

Alla termer pd ett stdlle Om Rikstermbanken | Kontakt | English Underha”s numera av
ingéngssidan Vilkommen till Rikstermbanken Sprakradet, Institutet for
Enkel sokning . . o .

S t lla termbank
R veriges nationefla termban sprak och folkminnen
Kallor 5ok i Rikstermbanken
Senaste nytt ‘
Fragor och svar ® enbart bland termer Oaven i all annan text ok

Hjalp

Senaste nytt om Rikstermbanken;

Nya och reviderade kallor laggs in successivt, se

Hittar du inte vad du séker eller har du termproblem du vill ha hjilp med? G4 med i Terminologiframjandet
och anvand dig av TNCs termtjanst. L&s mer.

Terminologicentrum THC farvaltar, Senaste uppdatering: 13 december 2017
utvecklar och underhaller Rikstermbanken Systemversion 0.97.42T @ Terminologicentrum THC

=
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Internet: termdatabaser
-]

https://iate.europa.eu
(“Inter-Active Terminology

: for Europe”, Translation
f1ate fugrenyer 0 Do Centre for the Bodies of

the European Union in
[seach [ Q] Luxembourg)

Last Queries (+) =

*

Uppdaterad version

« Source language « « Target language =
bg cs da de el en es et fi fr ga bg es da de el en es et fi fr ga november 2018
hr  hu it It Iv mt nl pl pt ro sk hr  hu it [is Iv mt nl pl pt ro sk
sl sV la  mul sl sV la mul O

Number of entries About |ATE

1185876
IATE (Interactive Terminology for Europe) is the EU's terminology database. It has been used in
Number of terms the EU institutions and agencies since summer 2004 for the collection, dissemination and
8216 152 management of EU-specific terminology. The project was launched in 1999 with the aim of

providing a web-based infrastructure for all EU terminology resources, enhancing the availability
and standardisation of the information.

© About IATE @FAQ
<& Download IATE [21ATE brochure

={/4"
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Internet: termdatabaser

Start | Infoga Design Animeringar Bildspel Granska

Utvecklare Format @

= ¥ ,lj = Layout - 7‘; |ﬁ =) = “E'i Textarientering - | AT D\_—|:l{ |_ <& Figurfylining ~ | 4 sok |

; |\_q"3J B Aerstan | — = =] Justera text - N AL TLEr 2 Kontur - || Ersate = |

x:::t"a . | pild~ % Ta bort ‘H E & U & & AllA”_ﬁ_| “g | Konvertera till SmartArt ~ !| %Al e Or?na Snabbvfnnnal =) Figureffekter = !| lg Markera ~ !

| urkiipp | swger | Tecken | stycke 5| Rita || Redigeiing |
[ i =

= Microsoft United States Change | All Microsoft Sites.
Language Portal oing [ svensk: menyflik,
menyflikssomrade

Search Terminology Downloads Provide Feedback Change langua: nors ka bé nd

How can you use
the materials on this

E|to | Swedish E| site?

' See the

ul
Product | All products B| | for details.

English

Microsoft Terminology Collection

English Translation Definition

The part of the Microsoft Office user interface above the main work area that presents commands and options to

Ribb: flikzomradet
fobon e the user. The Ribbon replaced menus and toclbars starting in the 2007 Microsoft Office system.

An area in a window in which commands and other controls are displayed in functionally related groups. A
ribbon menyfiikar ribbon can be divided into multiple views, known as tabs, and every tab can contain muttiple groups of controls.
Typically, a ribbon appears at the top of a window.
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Internet: termdatabaser

-]
Ordlistor:

Terminologi-lankar pa

Europeiska akronymer (

)




Internet: korpusar

Linguee m.m.

BE English 4=+

inguee | SR
o

* Extemnal sources (nof reviewed)

TR European Unkn #ncourages thrd SLates 1o 3cade 1o e 1980
Conventicn and supperts its cormect Imlementation by paricipating. inter
alia, bo the Special Commissions organized on a regular basis by the

Hague Conference on Private inemational Lan 4

rodee BUTON B

1N 00N 1 B MAASLNS AGNed Wilh PAANSE COURYIAS In The ottt
of the pelicy ramework for cooperation estacished under e Integraied

Login Feodl

na.ao

A angiuta sk Bl 1980 Srs
kaevenion och sibder dess koimekia gencmicrands bland annat gencm
# delta | de sarskilda kommitléer som regelbundel sammankallas v
Haagkonterensen 1or mlermationell percIran + pur-les suroea B

Unives Ge SIGarder S0M BverensKkoma med pAMNONSNaeT KM d6n ram
fer samaroete som faststalls | det integrerade instrumentst for stod infer

Pre-accession Inskrurnent, the Ewopean d

el europeiska och

Parinership Instrurnent and e Diveloprment Cooperasan
Cocparation INSrument, the Community must Be 326 10 provce
assiatance that supports the Andamental valus and key pokcy pricres

oth SaMarteln, mAse
3150 30m beframjar CUs grunclaggands varden och polikska
och nya pelitiska indialy Irin del inl I

of the European Union and new policy indiatves of the
commundy r1aAng 10 the Malntenance o peace, political stata
security from organised crime, proliferation of weapens of mass

Saniundst CrATaN3e UpRrAANlands v ned, poliisk stabiltel
bekamening av organiserad broRelighed. spridning av

destrucson and related materials, major and
epidemics, + o0

dex. puropa.ou

Whede 3 Memiber SLlis Qranls a penoa fof e comgiance with i new
Standard as referred 10 ariche 1 of this Regulation or a period for thie

och dartill retsterace material, s1ome hot som den

beknig ka ubvecklingen fie med sig och epidemier S——

1 3 Ll en rpdlemsstal bevilje e BASES] 151 UpDRIANgE v en iy
s1andard s480m anges | anikel 11 Genna 1orordning eller en Hasinst for

compliance of young EAIMers with the minsmum standards refemed b
article 4, second subparagraph, of this Regulation, the farmers remaing
ligitile for Mib COMpensalory Allowances retbrred i in Chagler v of
Regulation (EC) No 12571989 andfor for agrienvironment or animal
weltare suppart refermed 1o in Chagter V1 of hat Regulation during this
period provided the othes condions for graning these supports are met
300 poMand that e Farmar complias with the $13ndards concemed 3t

the end of ;e peried * dur-ten europs by

unga ] enlighet med
artikel 4, andra styckeli denna Reordning, skall jordbrukaren fortsalt vara

0 p gt kapatel v (EG)ne
12571880 cchielier till mil 5100 for gjurens
wnligt kapitel V1 | denna forordning under denna peniod uner

al vriga krare 16¢ o upglls och undes

ferutstining 3N JOrdbrUKam3 UPpRIler Barnda S1ANGAAGH vd panadens
it * eurdax euroos U

The Linnaeus University English-German-Swedish Corpus (LEGS)
(Forskningsprojekt Jenny Strom Herold

och Magnus Levin)
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Arbete med dversattningsminnen

Funktionsprincip och basbegrepp

TRANSLATION PROCESS CO NG



Forutsattning
- 000000/

Du har fatt uppdraget i elektronisk
form, dvs. som redigerbar fil!
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Funktionsprincip

1 This is a sentence. ==) Detta dr en mening.

‘new|sentence.m®) Detta r en ny mening.

Peter is a boy. m) Peterdren poike.

§ o>

This is a sentence. m=) Detta 4r en mening.

=N
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Basbegrepp
]

Oversattningsminne (TM)

Oversattningsenhet

Segment

Match
Konkordans/fragmentsékning
Arbetsdokument

Alignment

TRANSLATION PROCESS CONSULTING



Basbegrepp )

Oversattningsminne (TM = Translation Memory)
Databas med dversattningsenheter (TU = Translation Unit)
Ett kallsprak, ett eller flera malsprak
Kundspecifikt, amnesspecifikt, eller generellt
Filbaserad pa harddisken/servern eller i en SQL/Oracle databasserver

Byggs ut automatiskt




[Transistion Resuls - English-German

wr Project Settings & = & & >

Basbegrepp @ ==

English-German 2008-08-27 11:21'41 STUTTGART\dbrockmann

i e T - '“°:“"““’””""“’ e T N -
. ‘Getting-Started " Erste-
Oversattningsenhet Schritte
(TU = Translation Unit) _Finding-a-location-for-

vimnir b AatA _ ArindtAre

TB+

Segment pa kallspraket kopplat till det dversatta segmentet pa malspraket i
minnet

Systeminformation (vem Oversatte, nar)

Ibland metadata: kund, projekt, amnesomrade

<tu -creationdate="20080406T2134452Z" -creationid="ANNE">|
<prop -type="Att::Subject">Software</prop>. Ove rsattningsenhef i
<prop -tyvpe="Att::Type">Training -text</prop>l

<prop -type="Txt::Project">Training -CAT -tool=s</prop>l
<tuv -xml :lang="EN-U5">.]

<zeg>This -i=s -a -segment.</seg>l

</ tuvil)

<tuv -xml:lang="SE-SV">|

<seg>Detta "8r "2tt -Segment.</seg>l

</ftuv>l

exportformat *.tmx



Basbegrepp @)
]

Segmentering

En text delas upp i mindre delar med hjalp av element som punkt,
utropstecken, fragetecken, radbrytning etc.

Segment
Mening ”Detta ar en mening.”
Enstaka ord (rubrik, indexord) ”Inledning”
Isolerad fras (i lista, cell, etc) ”“Artikel”, "Antal”

Stycke ”Jag aker till Malmao. Dar har jag ett
mote. Motet borjar kl. 9:00."



Basbegrepp )
]

Match: Oversittningsenhet som hittas som dversattningsforslag i minnet. Olika sorters matchar:

Context Match: Samma kallsegment i samma kontext
Text: | have a cat. It’s white.

T™M: | have a cat. It’s white.

100% match = samma kallsegment

Text: | have a house. It’s white.
T™M: | have a cat. It’s white.

Fuzzy match = kallsegment liknar ny kadllsegment, e identisk

Text: | have a dog.
TM: | have a cat.

No match = forsumbar eller ingen likhet med kallsegmentet

Text: | am working as a farmer.
TM™M: | have a cat.

={/4"
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Basbegrepp )

-]
Konkordans

Sokmetod for sokning av delar av segment i minnet
Pa kallspraket, ofta ocksa pa malspraket

OBS: ej samma sak som fackordlista!

”Oversattarens basta vin”

Numera har de flesta program ocksa en automatisk fragmentsokning



Basbegrepp )

Arbetsdokument: Tvasprakig fil som innehaller segmenten pa
kall- och malspraket

Kan korrekturlasas

Kan anvandas for att uppdatera ett dversattningsminne
(hos dversattaren, byran, kunden...)

Varje CAT-verktyg har sitt eget arbetsformat. De flesta ar varianter
av XLIFF (XML Localization Interchange File Format)

(*.sdIxliff, *.mxliff, *.mgxlz, m.m.)

Kalldokument i originalformat -> arbetsdokument -> malspraksfil i originalformat



Basbegrepp )

- 1]
Alignment

Skapa oversattningsenheter av tva separata texter, kalltext och dess
oversattning, nar inget oversattningsminne finns men textmaterialet
ar [ampligt for ateranvandning. Det alignade materialet importeras till
ett dversattningsminne eller anvands som bakgrundskorpus.

3, Allmdnt General 3, |
Dessa anvandarvillkor (nedan "Anvandarvillkoren") galler The terms of this User Terms (hereinafter referred to as
fir denna webbplats (www.swedbank.se) som innehas av "User Terms") apply to this web site
Swedbank AB, Brunkebergs torg 8, SE-105 34 Stockhalm, (wvivs.swedbank.com) of Swedbank AB, with its principal
4. Sverige, organisationsnummer 502017-7753 (Swedbank). —————place of business located at Brunkebergs torg 8, SE-105 4.
34 Stockholm, Sweden, and registered in the Swedish
Companies Registration Office's registry under number
502017-7753 (hereinafter "Swedbank").
Genom att gd in pd Swedbanks webbplats och/eller By accessing the Swedbank web site and or using the
5 anvanda den information som tillhandah3lls pd eller via information and services provided on or via this web site 5
webbplatsen, godkénner bestkaren att Anvandarvillkoren you agree to be bound by this User Terms.
ar bindande far besokaren.
0Om Anvandarvillkoren skulle vara oférenliga med villkoren In the event of any conflict between the terms and
& fér ndgon tj&nst eller produkt, har villkoren f&r produkten conditions of specific products and services and this User G
eller tjansten foretrade framfor Anvandarvillkoren. Terms, the conditions specific to such products and )
services shall prevail.
7. 2 2. 7.
g Begrinsni i andningen av p ictions on the use of the web site 8.

Kul att veta:

Jenny och Magnus anvander sig av alignment-funktionen for att skapa

sin forskningskorpus LEGS. l/ IIJ



Overblick

Text \ / v
Text :>
7

8 8 7 -

* pptx “ This is a Detta ar en “ * ppix

sentence. mening.
* xlsx * xlsx
Thisis the last  Detta ar den
" .docx sentence. sista meningen. "docx

tvasprdkig

arbetsformat, orensat a

dokument
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2020-11-12 F | I fO rmat

*.html

* xml

=N
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"Dokument”format: filformat (urval)
-

[Z] 1.5pellChecker |2 1.5pellCheckerxml

6] 5. kontext tvd kolumner i3] 5. kontext tv kolumner.xlsx

@ Broc_Traditionals_Overview_layd_de @ Broc_Traditionals_Overview_layd_de.docx
@ Broc_Traditionals_Overview_lay3_de 'E] Broc_Traditionals_Overview_lay9_de.pdf
'E] Mormal 'E] Mormal.pdf

Presentation Presentation.pptx

T Text2 T Text 2.indd

=44
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Visa filnamnstillagg

-]
Visa filandelser:

Win 10 i Utforskaren under Visa
Sot  pea | Vs | Honteo

.:| [l F5rhandsgranskningsfanstret Extra stora ikoner [&] Stora ikoner Medelstora ikoner JI []] Gruppera efter ~

Sma ikoner EE Lista = Detaljerad lista [0 Laga till kolumner =

Kryssrutor for obj

[¥] Filnamnstillagg

Mavigeringsfanstret i & = = 5 Sort Dal rkerad Alt ti
avigeringstansire [TH Informationstanstret EE sammanfattning S innehall E&;t;rva fio Anpassa alla kelumner till innehall Dolda objekt jJ.;l;JTEkila ‘ e
Fonster Layout Aktuell vy Visa/dalj
Mappalternativ >
. . ] :
WI n 7 I Mlmant  Visning  Sakning
Mappvyer

Du kan anvanda det aktuella visningslaget .ex.

ARR Detaljerad lista eller lkoner) for alla mappar av den har
Utforskaren B ”
I Anvand i alla mappar I Aterstall mappar
der Ord |
under Ordna,
Filer och mappar -~
Ivl a p p - O C h Anvand guiden Dela {rekommenderas)

[ Anvand kryssntor far att markera objekt

Avancerade installningar:

Sokalternativ, D@
Visning: Fblj Déhtol;maenhater
filnamstillagg for i :

ka n d d fl Itype r Avbryt Verestal




"Dokument”format: filformat (urval)

Office-format:

Word, Excel, PowerPoint (... 2003, 2007, 2010, 2013, 365 ),
OpenOffice

Taggade format:
HTML, XML (kundspecifika och standardiserade), SGML...

DTP-format (Desktop Publishing):

InDesign, InCopy, FrameMaker, QuarkExpress, Quicksilver,
PageMaker...

PDF (Portable Dokument Format)

Programfiler:
Java Resources, *.DLL, *.EXE, *.NET

=N



Excel
1 —

9 e - (3 ﬂ} 5 Product_Listxdsx - Microsoft Exce... Elﬁu

|SE|| Infoga | Sidlayol | Formler | Data | Granski | Visa | Utveckl: | Tilligg |@ - g X ‘
1

ﬁ Calibri - |11 - E nfn | Source Target aA ? == & Sort [Nosorhng vl
i Ei'a | F | X U '||A‘ AT| — o h Technology Dept. Product List 0% X
1stra . || Ustering a 0
in- y | ieim T|| & k ﬁ "| - - 5 Description 0% X
Urklipp / Tecken f . 3. PCwith mouse and keyboard 0% X
=
Al hd l'\..‘ 'fr | D 4, MNotebook with touchpad 0% X
A 5, Gaming console 0% X
1(ID Description
L . p 5. MP3 player 0% x
2 |AX-1242243-B PC with mouse and
. 0%
3 |RT-4834995-R Notebook with tou 7. “rdesmose —
4 (QT-384238-Z Gaming console g, Cordiess keyboard e X
3 | TR-348357-U MP3 Pla‘!"er g, Wireless LAN adapter 0% X
6 ER-243953-T Cordless mouse . o X
qp, Smartphone &
7 TE-384735-G Cordless keyboard
; 11 Digital camera 0% X
8 |QW-93435-H Wireless LAN adapi ™
9 BV-184493-| Smartphone
10 aw-18374-0 Digital camera
11 i Translation preview Ofx
12 Product Code Description
AX-1242243-B PC with mouse and keyboard
13 RT-4834995-R MNotebook with touchpad
- QT-384238-7 Gaming console
| AL Technology Dept. Product Ll'_;t TR-348357-U MP3 player
Klar | E | iﬁ.||g. ER-243953-T Cordless mouse
TE-384735-G Cordless keyboard
QW-93495-H Wireless LAN adapter
BV-184493-1 Smartphone

QwW-18374-0 Digital camera



Linnéuniversitetet

</p>

60 hp

| programmet far du en bred praktisk och teoretisk grund for
ett framtida arbete som overséttare. Du kan férdjupa dina
kunskaper i engelska, franska eller tyska.

Du tridnas att dversitta och analysera clika texttyper, dven med
hidln av dinitala Averegdtninnauerkhm neh kormnicar Stor viket lEnns

</header>

[ Fackoversattning i engelska,
franska, spanska eller tyska,
¥ Magisterprogram

Engelska - Svenska

NY STUL

I'I!ll —

e

<p id="educatiocn-page-descripticon">
Du tré@nas att Gversitta och analysera olika texttyper, &ven med hj8lp av digitala &wversdttningsverktyg och korpusar. Stor vikt 1Eg

Source |

ra
=,

28.

29,

30.

3L

<main class="main-content clearfix">
<header class="main-content-header">
<hl id="education-page-education-name">Fack:ifZ4é;versz5228;ttning i engelska,

<span id="education-page-specialization-name">Engelska - Svenska</span>
«span id="educaticn-page-points-formatted”">60 hp</span

<div class="main-content-kbody">

<p id="educaticn-page-lead" class="lead">
I programmet fi&r du en bred praktisk och teoretisk grund fér ect framtida arbete som Gversittare. Du kan foérdjupa dina kunskaper i

franska, spanska eller tyska, magisterprogram </hil>

*Logga“in- €3

3 href="hitps://Inu. 5e/ systemsidor/lyssna-pa-inu. se-med-taj
“Lyssna- €1
Fackoversattning-i-engelska, franska,
spanska-eller-tyska, magisterprogram

[5pan id~ educabon-page-specialization-name e
- Svenska €5

: ge-points-formatted 3 LY
<m

I"programmet-fér-du-en-bred- praktisk-och’
teoretisk-grund-for-ett-framtida-arbete-som-
dversattare.
Dukan-fordjupa-dina‘kunskaper-i-engelska,*
franska-eller-tyska.

Dutrénas-att dversatta-och-analysera-olika
texttyper, avenmed-hjdlp-av-digitala*
dversattningsverktyg-och'korpusar.

| Target ‘

|oL & ¥ Q

0% XA
0% X
0% X
0% X
0% X
N
0% X
0% X
Changed never




InDesign

v WE~ | aovancen v | [B

§E§ X: | 7| 76,667 mm |""" :l | n rp-| .r?'a ih @ 1ot - [1 D 1=, §8  [Basic Graphics Frame] - # _
¥: (272667 mm | H: 2 | i, L ou| b sk | N . | [ 100% b = as O+ -
*Sample.indd @ 66% [Converted] =
s
) (ly eaces
k. @y LINKS
_g[}_‘ & LAYERS I
oad Safe
L . & p] OBJECT STYLES -
N Education
] Jx EFFECTS
G‘ B 0 1
travulling bo and Eom school. Thss highli | -
- :ilnpnnh:nofmd:d;’rymuim.ﬂ? : # PARAGRAPH STYLES l
Tansi® Fective sdication prograneneg coeld Balp prasemt 1
E‘ ad;ﬁunmbptudmux:ihunﬁlglmw (Mo Styles) &
fvary day of the wesk. -
Basic Par; -
: o o\ CHARACTER STYLES
= Footnote =]
i b childrae of sl ages: S Body text =
= Schoal chddran wndar 10 yeams shodd always be acoemupaniod by 2o adali | 1
|] = a traffic eevimonmant 2= childrsn under § should ks tair band held wids Caption =
[ Parats can halp their childsee by walking with themm along tha routa bo ] Hznging indent =
| 2 showing team how amd whars 2o crons. Childsee of ol ages should be ]
prught 5 Sl s S Croas Ciace 2t all fimas. 1 Headline =]
@ + The Aased Sy Edetion Progromme fhr Sehoals® sheuld ks tragss to 2ll |
/ hildrsn under 10 wears of age. Childraz should be fmiliar with 2l kinds of fuzc- Subhead 1 = - ,
: .'-Auxmunq:mnﬁccm@mquﬁna,muwmm 4 G 9% Gl T
@ sllipap mamwemsar is avsdakls te assist childrsn aiving at sekes] in ths mem| :
&
=T 1 STOP en the fooeath befiors seapping out en the road.
2 DON'T hury - WATT until the raad i claz.
-' 3 LOOK right, lsét amd right agzm 1o make v fhas dhare 5 mo madin
4 WALK straigie across tog road 22 2 samsible pacs.
5 KFED WATCHING fir trefe untl vo roack fha oilar ids safily
1 <[ ¥ @ lemor @, 3 -




InDesign
- 000000/

Children of all ages should be taught to follow the Sate Cross Code at all
times. The Safe Cross Code 1s particularly vital for children who do not have ac-
cess to pedestrian crossings as they walk to school.

STOP bn the footpath before stepping out on the road.
hurry 4 WAIT fintil the road 1s clear.

richt. left and richt again to make sure that there 1s no traffic.
-

Th

Children-of-all-ages-should-be-taught-to-follow-the- Safe-
Cross-Code-at-all-times.
@ The-Safe-Cross-Code-is-particularhy-vital -for - children- o
=veTorman who-do-not-have-access-to-pedestrian-

Ccross|s s atee s ellings-as-they-walk -to-school.
F
,:‘?

nghL left-and- nght- ] Titta-till viEnster, -hﬁger-och-sedanﬂranster lgeufm-a.tt-
again-to-make-sure-that-there-is-no-traffic. vara-sakert-att-inga-bilar-passerar.

Development,- Depa.ttumt of- Educatmn, Dublin-4.

A



Filformat i memoQ, Memsource och
SDL Trados Studio

NET urce VL)
Adobe FrameMaker filter
Adobe FrameMaker filter 2
Adobe InDesign IDML filter
Adobe InDesign INX filter
AuthorlT project files
Bilingual DOC/RTF filter
Cascading filter
Composite (embedded) filter
DITA document filter
Excel 2003 XML fitter
FreeMind mind map filker
HTML filter
Image fitter
Java properbes filler
JSOM filter
Microsoft Excel 2007-2016 filter
Microsoft Excel filter
Microsoft PowerPaoint 2007-2016 filter
Microsoft PowerPaint filter
Microsoft Visio chart filter
Microsoft Word 2007-2016 filter
Microsoft Word filter
MS Help Workshop filter
MSG filter
Multlingual delimited text filker
Multilingual XML filter
OpenDocument filker
PDF (Portable Document Format) filker
Plain text filter
PO Gettext filter
PSD filter
Regex text filter
Scalable Vector Graphics drawing filte:
SDLXLIFF filter
SRT filter
TMX filter
TTX filter
TXML fiter
Typo3 page filter
‘WordPress (WPML) filtar
‘WorldServer filter
XLIFF filter
XLIFF.doc fiker
XML filter
YANL filer
ZIP filter

File Import Settings

MS Word

MS PowerPoint

MS Excel

Multilingual MS Excel

HTML

XML

Multilingual XML

Adobe InDesign

Adobe FrameMaker

Adobe Photoshop

XLIFF 1.2

XLIFF 2.0

SDLXLIFF

Trados TTX

a8 ™

JSON

Properties

csv

YAML

DITA

DocBook

PO gettext

i05 Strings

Android Strings

PHP

Windows RESX Resources

PDF

Markdown

Quark Tag

Character Set

E] SOL XLIFF

H TRADOStag

[#] sDL Edit

) Microsoft Weord 97-2003

) Microsoft Word 2000-2003
@ Microsoft Word 2007-2016
ﬁ_" Microsoft Werd 2007-2013
W) Microsoft PowerPoint 97-2003

iH) Microsoft PowerPoint XP-2003
[ Microsoft PowerPoint 2007-2016

&) Microsoft PowerPoint 2007-2013
uﬂ Microsoft Excel 2007-2016

&l Microsoft Excel 2007-2013

&) Microsoft Excel 97-2003

&) Microsoft Excel 2000-2003

@4 Bilingual Excel

H SDL Trados Translator's Workbench
[El Rich Text Format (RTF)

@ Microsoft Visio

& XHTML 1.1

B HT™MLS

& HTML 4

& Adobe FrameMaker 8-2018 MIF
*% Adobe InDesign C52-C54 INX

1 Adobe InDesign CS4-CC IDML

Il Adobe InCopy CS4-CC ICML

¥= OpenDocument Text Document (ODT)
£ OpenDocument Presentation (ODP)
% OpenDocument Spreadsheet (0DS)
@) QuarkXPress Export

) XLIFF

fL) XLIFF: Kilgray MemoQ

£ XLIFF 2.0

& WaXiff

0 POF

&l Comma Delimited Text (C5V)

B Tab Delimited Text

[ Java Resources

@) Portable Object

B SubRip

© JsoN

& XML: Microsoft NET Resources

[ XMLt OASIS DITA 1.3 Compliant

[ XML: QASIS DocBook 4.5 Compliant
& XML: Author-it Compliant

& XML: MadCap Compliant

[ ¥ML: W3C ITS Compliant

[ XML Any XML

=17
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Vilken text ska oversattas?

Den som tar in originaltexten till vald verktyg styr vilken
text som blir synlig och atkomlig for 6versattning.

Exempel:

- Ska kommentarer i Wordfilen oversattas?

- Ska alla kolumner i en Excelfil oversattas?

- Ska anteckningsidorna i en PowerPointpresentation
oversattas?

Uppdrag fran byra: projektledaren forbereder texten
Uppdrag fran direktkund: du forbereder texten



Overblick

Text \ / v
Text :>
7

*.html

t 7 I

* pptx “ This is a Detta ar en “ * ppix

sentence. mening.
* xlsx * xlsx
Thisis the last  Detta ar den
" .docx sentence. sista meningen. "docx

tvasprdkig

arbetsdokument a l/J
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Termdatabas

Oftast integrerad eller del av CAT-verktyget

TRANSLATION PROCESS CO NG



Termdatabasverktyg
]

Termdatabas = fackordlista

Verktyg for att samla och lagra fackord
Databas med termposter
Tva- eller flersprakig
Termer finns alltid med

Tillaggsinformation kan finnas med: definition, genus, kalla,
anvandningsexempel, rekommenderad/férbjuden....

Nya termer/termposter laggs till vid behov

EMN S5V DE Genus
Excel . file fil Datei f
* exit avsluta beenden
shortcut |snabbtangent |Tastenkombination |f




Termdatabasverktyg

Integrerad komponent i de flesta CAT-verktyg

English-German - Translation Results - J;' X | |Term Recognition - 0 X
3 Project Settings.. | Jo Jo fo | & =S NENE )
Finding-a-location-for-your-photo-printer = photao printer
rrrrrrrrrr
Finding-a-switabie-location-for-your- - Geeigneten-Aufstellungsort-fir-lhren-Fotodrucker-finden
photo-printer

Finding-ar-appropratea-location-for-your- 4| Passenden-Aufstellungsort-fiir-lhren-Fotodrucker-finden
photo-printer

English<Geman 2008-11-02 18:42:06 STUTTGART dbrockmann
Englizh-German - Translation Results | Concordance Search | Messages | Comments Term Recognition | Termbase Search
SamplePresentation. ppte.sdlxliff [Translation]” 4 r v X

\SampleP C\SampleProj

Getting- Started Erste-Schritte

Find'ﬁg-a—beeﬁheﬁr-TJ_ r-  Geeigneten- 5
_your|photo-printer Aufstellungsort-fur-

Inren-Fotodrucker-
finden




Termdatabasverktyg
]

SDL MultiTerm - Sample ‘ ESREERTSCT

1 i ools Help |

#| (No input model) - ﬁ i . ‘ E a i i ﬂ ‘i ‘I
vMFlagslayom vﬁmu - &
& 8 & ¥ (Nofiten -

Terms <« | | photo printer : Sample 4 p v X
Entry number: 10 o
Browse - B X il
Matrix Photolithograph MistJet Nozzle Engineering (MPNE) ~ = English
Matrix Precision Pixel Printer (PPF) EIE
matrix precision pixel printer (PPF) photo pr'lrl.ter
Matrix VitaChrom 100 araphic:
minimized
MistJet
Mistjet 3
Nextgeneration
Faper LED
ﬁﬁr Iiiht
hoto-print: 3
Ehng;ner Status:  Preferred
picture dyes photo-printer
Picture Dyes Status: Forbidden
power cable
power cord rma
proven methodology 5 L= L
quick
SE (Standard Exposure) Copy Il i
Security Inteligence
server e
| SuperSmall Beaded Technology || 28 L
B RTTENHL
| Browse | Hitlist| Termbases
— & H French
| imprimante photo l
& Catalog El Japanese |
I SAIULA il |
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woie | \/ad gor ett CAT-verktyg?
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Vad gor ett CAT-verktyg? (1)

- 1]
Grundlaggande:
Laser in elektronisk text
Ar (ndstan) sprakoberoende
Delar upp texten i mindre enheter: segmentering

Tittar pa ett segment och soker samma eller liknande teckenkombination i
en databas med dversattningsenheter

Vid traff, presenterar en eller flera traffar for oversattaren: kallmeningar
och deras oversattningar

Ger oversattaren mojlighet att godkanna eller modifiera traffar, eller
skapa helt nya dversattningar

Lagrar oversattarens oversattningar for ateranvandning i framtiden
Kommer ihag, aven om du har glomt!
Bidrar till konsekvens!



Vad gor ett CAT-verktyg? (2)
- 1]

Utover det

Hanterar manga olika filformat i samma granssnitt, dversattaren
behover inte ha tillgang till alla olika originalprogram

|dentifierar och gor skillnad mellan text och kod (-> layout,
funktionalitet)

Med hjalp av instéllningar utesluter text fran 6versattning
beroende pa uppdraget

Ger Oversattare visst utrymme att paverka layouten

Tillhandahaller stavningskontroll, kvalitetssakringsfunktioner, m.m.

=N



Analys som basis for prisberakning
- 1]

Beraknar dversattningsvolymen genom analys mot 6versattningsminnet:

jamfor texten med ett 6versattningsminne, visar statistik (antalet matchar
i olika kategorier) som basis for

- beslut om atagande av uppdrag

- tidsuppskattning

- prissattning/prisforhandling med kunden/byran

Totals

Total Type Segments Words Characters Percent Placeables Tags

Files:4 PerfectMatch 0 0 0 0.00% 0 0

Chars/Word:5.26 Context Match 2 4 28 0.14% 0
Repetitions 19 47 268  1.61% 19 ]
100% 4 22 130 0.75% 2 2
95% - 99% 1 20 91  0.68% 4 4
85% - 94% 2 14 4 0.48% 0 0
75% - B4% ] ] 0 0.00% ] ]
50% - 74% ] ] 0 0.00% ] ]
New 138 2814 14765 96.34% 118 22
Total 216 2921 15356 100% 143 28




Analys som basis for prisberakning
-

Kategori Pris E’:’;Z’“'“‘ Viktat pris
100% match procentsatser anvdnds sd gott som alltid i
ar bara e
och repetitioner: x 25% av ordpriset exempell samarbete med "insatta”
Olika
kunder (byrder och
procentsatser Y
Fuzzy matches y ‘ o B
(85-99% match): 50 % av ordpriset infervaller eknologimedvema
forekommer! SIUﬂ(Uhder)
No match -
(0-84% match): full ordpris
Type Segments Words Characters Percent Placeables Tags
PerfectMatch 0 0 0 0.00% 0 0
Context Match 2 4 28  0.14% 0 0
Repetitions 19 47 268 1.61% 19 0
Antal x*25%+Antal y*50%+Antal z*100% 100% 4+ = 130 0.75% 2 2
.. . e . . 95% - 99% 1 20 91 0.68% 4 4
= Antal ord for prisberdkning (viktat) P 5 14 24 0.48% 0 0
75% - 84% 0 0 0 0.00% 0 0
50% - 74% 0 0 0 0.00% 0 0
New 188 2814 14765 96.34% 118 22
Total 216 2921 15356 100% 143 128

=1VAN
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FORALDRAT!

Ordpriser

Sprakkombinationer Oversittningshyrier Direktkunder
Translation agencies Direct clients . .
Fran: 2007 2011 2007-2011 2007 2011 2007-2011 Prissattnin g per o rd
SEK SEK % SEK SEK % .o . —~

Danska till svenska 1,19 1,17 _1,7% 1,67 1,71 +2,1% SGmmGHSTG”nmg av SFO
Engelska fill svenska 1,21 1,14 -6,2 % 1,62 1,60 -1,3%
Finska till swanska 1,438 1,44 -2,6% 1,85 1,85 —0,2 % som resu Iqu av
Franska till svenska 1,22 1,14 —6,6% 1,67 1,54 -8,4% prisen k(':':’ren b | an d
Italienska till svenska 1,40 1,22 -14,9% 1,80 1,44 —25,4 %
Norska till svenska 1,18 1,19 +0,5% 1,67 1,77 +5,4% medlemmarna 2011.
Spanska till svenska 1,25 1,03 -21,7% 1,58 1,42 -11,6%

(o]
Tyska till svenska 1,31 1,20 —S,1% 1,74 1,66 -4,9% Antal del'rago re: 38,3 /o,
Andra sprak till svenska 1,48 1,73 ” f o b d
Svanska till engelska 1,38 1,30 -5,9% 1,77 1,84 +3,6% alla rra g or esvarades
Svenska Pllﬁnska 1,38 1,50 1,76 1,88 av 33 'I personer
Svenska till franska 1,40 1,09 1,68 1,29
Svenska till spanska 1,47 1,10 173 1,27
Svenska till tyska 1,35 1,21 -11,8% 1,77 1,62 -9,4 %
Swvenska till andra sprak 1,31 1,66
Danska till engelska 1,46 1,39 1,91 1,94 80% av dessa anvdnder
Franska till engelska 1,30 1,34 1,69 1,59
Norska till engelska 1,44 1,27 1,88 1,40 ett CAT-ver kTyg
Tyska till engelska 1,37 1,40 1,77 1,69 ° . °
T 121 157 dtminstone emellanat

© Sveriges Fackdversattarfsrening (SFO), Prisenkat 2011




Vem bestammer priset?
]

Samarbetar du med en direktkund (ej dversattningsbyra / ett
sprakforetag):

Oftast ar det du som offerarar ett pris

Pris per ord eller totalpris

Samarbetar du med en 6versattningsbyra / ett sprakforetag:
Du tillfragas oftast vilket ordpris du vill ha
Byran meddelar vad den ar beredd att betala

Oftast pris per ord



Vem anvander sig av CAT-verktyg?
- 1]

Samtliga deltagare i “6versattningsprocessen”:
Slutkunden = bestallaren
Oversattningsbyran

Oversattaren

Idag maste en fackoversattare kunna anvanda CAT-verktyg for att vara
konkurrenskraftig pa marknaden!

| manga fall styr uppdraget vilket verktyg som borde anvandas.

Ibland kan man anvanda annat verktyg an det uppdragsgivaren sjalv kanske
har: kompatibilitet av format, verktyg och databaser/exportfiler



Nar anvands CAT-verktyg?
- 1]

Elektronisk kallmaterial

Dokumentation som uppdateras, t.ex. handbocker, webbsidor,
arsrapporter, etc.

Krav pa konsekvens och effektivitet, aven kostnadseffektivitet
Korta deadlines och/eller store volymer

Automatiserade arbetsfloden

Oversattare specialiserar sig - dversattningsminnet ocksa!



Nar anvands CAT-verktyg sallan eller

Inte
I

vid dversattning ar skonlitterara texter

(Reklamtexter)

(Journalistisk material)



Olika CAT-verktyg
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CAT(TM)-verktyg: Det finns manga!

Verktyg med desktopklient och lokala databaser (TM, TB) samt ofta serverversioner som kan koras i molnet

Across ( ): Across
Atril ( ): Déja Vu
» memoQ (tidigare Kilgray) ( )
MultiTrans, numera SDL-agd ( )
OmegaT ( ), Open Source
» SDL ( ) : SDL Trados Studio (*)
Star ( ): Star Transit
Wordfast LLC ( : Wordfast *

Molnbaserade verktyg:

Matecate ( ) *
» Memsource Technologies ( ) : Memsource *(tjanst, molnbaserad)
Smartcat ( ) *
Wordbee ( ): Wordbee *(tjanst, molnbaserad)
XTM ( ) (tjanst, molnbaserad) *

Egenutvecklade (foretagsspecifik), icke-kommersiella

={/4"
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TM-scenarier

Lokal installation av programmet, dokument och databaser
Desktopklient, dokumenten och resurser (TM, TB) ligger pa den lokala datorn

Desktop-
/ , ‘ ‘\\\I program
T

"
MM




TM-scenarier

Allt finns i molnet (Dok, TM, TB m.m.)

Databaserna kan

Allt som krdvs anvdndas av flera

- - oversdattare samtidig.
‘ hos 6versattaren
y A\ dr en browser
AN

=N
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TM-scenarier

Lokal installation av programmet, databaser i molnet

Program och dokument ligger lokalt, resurser (TM, TB etc.) ligger pa en server i molnet och

delas ev med andra anvandare

A
S

o
-

111
AL

CAT

Online

server
eller

LAN-

server

Databa-
serna kan
anvdndas

av flera
samtidig.

2l

TRANSLATION PROCESS CONSULTING



zouiz ] Utbyte mellan olika system
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"Flyttar” information mellan olika

sxstem Skomﬁatibiliteti

C.)Ve rsatt n i n gs m i n n e éverséﬁningsminne:

filbaserad eller pd en

= *.TMX (Tra nS|ati0n Memory EXChangE) databasserver (SQL, Oracle)

Y S
N— TMX N—
<tu-creationdate="20080406T213445Z" -creationid="ANNE">]
<prop tyvpe="Ltt::S5ubject">Software</prop>.l
<prop -type="Att::Type">Training -text</prop>l|
<prop type="Txt::Project">Training -CAT -tools</prop>l
<tuv -xml:lang="EN-TUS">| \ J/
<geg»This -is -a segment.</seg>l
</ tuvsl

<tuv -xml :lang="5E-5V">.]
<segrDetta &r ett -segment .</segrl Vel’kTyg B
</ tuvyl

2l
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"Flyttar” information mellan olika

sxstem Skomﬁatibiliteti

Arbetsfilerna

framst * . XLIFF (XML Localisation Interchange File Format)
Varje verktyg har sin variant av XLIFF

Tva- ’ Tva-
sprakig sprakig

doc e doc

Verktyg A Verktyg B

Overblick




"Flyttar” information mellan olika

sxstem Skomﬁatibiliteti

Termdatabaser

- * XLS(X) (Excel)
- * TBX (Termbase Exchange)
- (MultiTerm XML)

TBX, Excel,

A MultiTerm XML, —
—

D E | F | G
Engelsk Dansk Spansk Fransk
abrasive wear friktionsslid (1) desgaste abrasivo busure abrasive
wear slitage abrasian usure (1)
attritian friktionslid (1) desgaste attrition

i abrasion i

abrasion abrasion




Maskinoversattning

Ar aktuell for alla fackdversattare!
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Maskinoversattning
- 1]

Online-tjanst “producerar” dversattningar

Ansatser:

- grammatiska regler

- statistik (sannolikhet vilka ord som forekommer i vilka
kombinationer

- neuralt

Neural Machine Translation (NMT) ar det alla pratar om idag, texter
oversatta med NMT ar kvalitativ battre an tidigare ansatser.

Wikipedia: Neural machine translation (NMT) is an approach to

that uses a large to
predict the likelihood of a sequence of words, typically modeling
entire sentences in a single integrated model.



Maskinoversattning
- 1]

Anvandningsomraden

Maskindversattning av ofta stora textmangder dar snabb
tillgang till information ar viktigare an absolut korrekthet
(Facebook, supportdatabaser, patentdatabaser, m.m.)

Som input till dversittaren. Oversattaren far en
maskinforoversatt text att redigera. Den fardiga
dversattningen ska leva upp till vissa kvalitetskriterier, men
maste inte alltid vara lika bra som en "manuell” 6versatt text,
> "fit for purpose”.

Oversattarens stdd under dversattning vid “no match”

2l



Maskinoversattning
- 1]

Olika MT-tjanster

Deepl

Globalese
GoogleTranslate
KantantMT
MicrosoftTranslator
Omniscien Technologies
Promt

SDL Language Cloud/BeGlobal
Systran

Tilde

M.m.

2l
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Fortsattning i december
]

Hands-on ovningar vid datorn :

Introduktion till SDL Trados Studio 2019
3, 4 eller 7 december

9:15-17:00

Windows: SDL Trados Studio

Spraklabbet Online-workshop!
sak-UB3008
Introduktion till Memsource

8 eller 11 december
9:15-17:00

sal- ' -
Online-workshop!

TRANSLATION PROCESS CONSULTING



Anmalda =
Svar wm
PC: 19/40

MAC: 12/40

Anmdlda

Studio (PC): 17/40 Svar
Memsource (MAC): 10/40

3 december, SDL
Trados Studio
(PC)

O

O Sandra
Farm

O G Hanna
Larsson

O Karolina
Gorska

O Souhar
Alhabsh

O Anna

Gertrud Catarina
Hultgren

3 december,

SDL Trados

Studio (PC)
O

] Eva
Botéus
O Anna

Andrew-Nielsen

FULL!

A

4 december, SDL
Trados Studio
(PC)

O

O

Susanne Helen
Storgérds

O 0 Emelie
Nestor

O Nadine
Larsson

O Emely
Blixt

O Brita
Bodin

4 december, SDL
Trados Studio

(PC)
O

[ 0 Hasna

Hasan Abed
Musleh Jabarin

O Charlotte
Graham Hjorth

O Janin
Laurer

O Anneli
QOlsson Hagman

O Elisabeth

Henderson

7 december, SDL
Trados Studio

(PC)
O

O Sisiwe
Amukena Nygvist
O Martin
Knoos

O

Susanne
Eriksson Talls

[ Gyongyi
Szekeres
O David

Eriksson

7 december,

SDL Trados

Studio (PC)
O

8 december,
Memsource
(MAC)

O

@
Josefine
Eriksson

U Vi

Spencer Walle
O Patricia
Loggarive

8 december,
Memsource
(MAC)

O

] Evelina

Magnusson

11 december,
Memsource

(MAC)
O

O Sofia
Hamberg

O o Yao Li
O

Anna

Nésstrom

11 december,
Memsource
(MAC)

O

] Yuan
Sun
O

Josefina
Hansson

| ‘ Birgitta

Banze

TRANSLATION PROCESS |




Programvara infor workshopen

SDL Trados Studio 2019, PC

Studio-anvandare behover installera SDL Trados Studio 2019 pa sina datorer
(PC) infor workshopen!

Programmet laddas ned via en lank som publiceras pa MyMoodle
30-dagars testlicens

Licensnyckel for tidsbegransad licens via LNU (galler till slutet av sep 2021)

Memsource, Mac:

molnbaserad, kors i en browser (ingen installation ndédvandig)
LNU’s instans med personliga logins som AKW delar ut infér workshopen

ALLA:

Ladda ned 6vningsfiler fran MyMoodle for arbete under workshopen!
Se helst till att ni har tva skarmar! (en dar ni arbetar, en dar ni tittar!)

2l



Fortsattning efter hands-on:

Oversattning av text i CAT-verktyget
Inlamning av text, minne och termdatabas

Aterkoppling "funktionalitet”
Inlamning:

15 jan (helfart)
15 feb (halvfart)
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Komprimerad mapp
]

Skapa komprimerad mapp i Windows:

Markera en eller flera filer samtidigt i Utforskaren
(Ctrl+musklick pa fil nr 2)

Hoger musknapp: Skicka till: Komprimerad mapp
Filandelse: *.zip eller *.jar

wig | Skcketi > £ Bluetosth-enhet KGHOW. docx 2015-03-16 22:16 Microsoft Word-d... 13 kB
MsOCache | Kipput ﬂ DDDDDDDD g SWINRE_BACKUP_PARTITION zip 2017-09-25 11:47 WinRAR ZIP archive 1kB
NVIDIA g [] Dropbex
Perflogs - _A EmEditor
Progam |  Skapagenvig ‘| E-postmottagare
Program (: & Fa
ProgramData | bytnamn & F
;deows eeeeeeeeee ! oK rad mapp
WINRE_BA RTI o -
1 Q m
5] IFRToolLog ot =t B Skrivbord (skapa genvg ) ‘
’ Q sy
a ewer




Anne Katrin Welp

E-post:
anne@akwconsulting.se

© AKW Consulting 2020
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